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Ambiente Java - Procedimento de Configuracao

1 Ambientac¢ao

1.1 Instalagdo do JDK
Inicialmente vocé devera instalar o jdk (Kit de Desenvolvimento Java). Por padrdo utiliza-se

a versdo 1.6-atualizacao 45. Este .jar encontra-se no diretorio:
» \\selene\GRUPO\NTNSISTEMAS\JAVA\WINDOWS\JDK

Escolha a versdo conforme o seu sistema operacional.

1.2 Configurando varidvel de ambiente
Apos instalado o Kit € necessario ambientarmos a maquina. Siga o0s passos abaixo referente as

imagens:

&M C,
L SPET Recolher
> i 05 (C
>y RECO] B Gerenciar
> G0 NTI Abrir em nova janela
> 52 publi Fixar na Tela Inicial
Mapesr unidade de rede...
P
» S Rede Desconectar unidade de rede...
Adicionar um local de rede
5 itens By B =
Propriecades

Passo 1

No Passo 1 vocé ira em “Computador” e selecionara a opgdo “Propriedades”.

4 1™ » Painel de Controle » Sistema e Seguranca + Sistema v & Pesquisar Painel de Controle O

Inicic do Painel de Controle PRI - P
Exibir informagdes basicas sobre o computador

| Gerenciador de Dispositivos Edicdo do Windows

Configuragdes remotas Windows 8 Pro --

Protecio do sisterna © 2012 Microsoft Corporation. Todos os - WI n d OWS 8
Configuragées avancadas do direitos reservados. -

sistema Obtenha mais recurses com a nova
edigde do Windows

e

Sistera
Classificagao: m Indice de Experiéncia de Windows
Processador: Intel(R) Core(TM) i5-3330 CPU @ 3.00GHz 3.00 GHz
Meméria instalada (RAM): 4,00 GB (utilizével: 3,70 GB)
Tipo de sistemna: Sistema Operacional de 64 bits, processador com base em x64
Caneta e Toque: Nenhuma Entrada & Caneta ou por Toque ests disponivel para este video

Nome do computader, dominio e configuragdes de grupo de trabalho
Nome do computador: mal-051672 & Alterar

Mome completo do ma1-051672.CEUMA.EDU.BR configuragdes

Consulte também computador:

Central de Acfes Descrigéo do computador:

Windows Update Dominio: CEUMA.EDU BR
Informagdes e Ferramentas de Ativacio do Windows
Desempenho

Windows ativado Exibir detalhes na Ativagdo do Windows
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Passo 2

No Passo 2 ird selecionar a op¢ao “Configuraces avancadas do sistema”.

Nome do Computador | Hardware | Avangado | Protegdo do Sistema | F{emotol

Para tirar o maximo proveito destas aterages, & preciso ter feito logon como
adminiztrader.

Desempenho

Efeitos visuais, agendamento de processador, uso de meméria e

memdria virtual
Corfiguragdes. .

Pedfis de Usuario
Corfiguragdes da drea de trabalho relativas 3 entrada

Configuragies. ..

Inicializacdo e Recuperagdo

Informagdies sobre inicializagdo do sistema, falha do sistema e
depuragéo
Corfiguragdes...

Vandveis de Ambiente. .

| 0K | | Cancelar Pplicar

Passo 3

No Passo 3 selecione “Variaveis de Ambiente ”.
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e e e e

Propriedades do Sistema ta de arquivos

ita d i
Nome do Computadar | Hardware | Avangado | Protecdo do Sistema | F{emoto| a- € arquives

Varia

Varidveis de usudrio para 33

Mome da varidvel: | JAVA HOME

Varidvel Valor "

Valor da varidvel: | C:\Program Files (x36)avaljdk1.6.0_45| |
TEMP olS
™P

el | OK || Cancelar |

Mova... || Editar... || Excluir |

Varidveis do sistema
Varidvel Valor 6
azl.log Destination =file
ComSpec C:Windows\system32\omd. exe
FP_NO_HOST C... NO
NUMBER_OF_P... 4 W

| Mova... || Editar... || Excluir |

I T

| oK || Cancelar | o C

v Windmwe

Passo 4

No Passo 4 iremos criar uma nova variavel de ambiente, clique em “NOVO”, aparecera uma
nova janela solicitando a nova variavel do usuario. Informe os seguintes pontos:
Nome da Variavel: “JAVA_HOME”

Valor da Varidavel: “caminho_da_instalacdo_do_seu_jdk_conforme_mostra_o_exemplo”

Varidveis de usuario para 3506

Varigvel Valor

JAVA_HOME
TEMP
™P

C:\Program Files (x86)\Javaljdk1.6.0_45
%eUUSERPROFILE%: \AppData'Local {Temp
%l ISERPROFILE % \AppDataLocal {Temp

Varidveis do sistema

Mowa... || Editar... || Excluir

Varidvel

PATHEXT
PROCESSOR_A...

Valar

Windows_NT

C:\Program Files\Common Files\Microsof. ..
.COM;.EXE;.BAT;.CMD;.VES; .VEE;.15;....
AMDE4

| Mowva...

|| Editwr.. || Exdir |

CK || Cancelar |
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Passo 5

No Passo 5 vocé ira “Editar” a variavel de Sistema “Path” adicionando a nova variavel

criada.

Propriedades do Sistema

Mome do Computador | Hardware | Avangade | Protecdo do Sistema | Remoto

Variaveis de Ambiente

Varidveis de usudrio para 3508

Varidvel Valor
JAVA_HOME C:\Program Files
TEMP %lSERPROFILE®
T™MP %eUSERPROFILE®
Nome da variavel: | path
MNovo... S
Valor da variavel: | he-maven-3.0,4\bin\EELVEMEE L= o |
Varidveis do sistema Cancelar
Varidvel Valor
Qs Windows_NT
Path C:\Program Files\Common Files\Microsof. ..
PATHEXT JCOM; . EXE;.BAT;.CMD; . VBS; . VBE;. 15;....
PROCESSOR_A... AMD&4 A
MNovo... Editar... Excluir
e javac -wversion novamente. Agc
oK Cancelar ara comecar a ser usado.
Passo 6

No Passo 6 vocé devera fazer o link entre a nova variavel adicionando-a no caminho Path,

para fazer isso verifique se a ultima variavel possui ao final “\bin”, caso ndo tenha, acrescente.

Registre o seguinte caminho:
>

Atencao!!

“;%JAVA_HOME%\bin”

> Instale a jdk conforme o seu sistema operacional, sendo 32 ou 64 bit.

1.3 Testando versdo do Java
Apos as devidas configuracdes vamos testar se 0 nosso sistema operacional ja reconheceu a

nossa variavel. Para isso vamos abrir o “cmd” digitando o comando:

» “java-—version”
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Microsoft Windows [versdo 6.2.92081]
(c) 2812 Microsoft Corporation. Todos os direitos reservados.

C:~Users~3586>java —version
Jjava version "1.6.8_45"

Java{TM> SE Runtime Environment <(build 1.6.8_45-hB6>

Java HotSpot(TH> 64-Bit Server UM <huild 28.45-bB1l,. mixed model

C:Users~3586>

Passo 7

Vocé deverd visualizar a informacao conforme a imagem. Caso ndo apareca, lembre-se que
estamos falando do Windows, tente reiniciar seu computar e realize o comando novamente. Se o

erro persistir chame alguém da equipe que trabalhe com o Java a mais tempo.

2 Ambientando o Eclipse

2.1 Usando Eclipse Padrdo
Para o Desenvolvimento Web, escolha um eclipse Java EE. Vocé podera baixar diretamente

do site do eclipse e configurar ou pegar um ja configurado em:
> “N\selene\GRUPO\NTI\SISTEMAS\JAVA\WINDOWS\ECLIPSE ”
E recomendavel escolher o arquivo “eclipselndigo.rar”. Na descompactacio podem

aparecer alguns erros, mas prossiga até o final para testar se estes afetaram o IDE.

2.2 Ambientando Eclipse
Apos a descompactacdo vocé devera fazer alguns procedimentos de ambientacéo para o

desenvolvimento. Os passos sdo simples. Inicialmente, por questdes de boas praticas vamos
organizar nossos diretorios para o desenvolvimento. Caso vocé possua duas parti¢ces deixe aquela
onde ndo sdo instalados seus programas para esta boa pratica.

1. Na raiz deste diretorio crie um novo de Nome “Java”

2. Dentro do diretorio “Java” crie dois novos de nomes “workspace” e “ferramentas”
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Em ferramentas vocé colocara, como o nome ja sugere, ferramentas de auxilio ao seu
desenvolvimento. S&o estas:
» Tomcat;
AgquaDataStudio (caso n&o use o Server Management Studio);
Maven;

iReport;

vV V V VY

Jboss;

Agora siga 0s passos abaixo para as boas praticas de configuracéo da IDE:

1. Abra seu eclipse e defina o diretdrio criado como o seu workspace de trabalho;

2. Va no menu do eclipse “Window ” -> “Preferences ”. Abrird para vocé uma nova

janela. Digite nela a palavra “Maven”;

Window | Help

i MNew Window

Mew Editor

g

Mew Editor (Side by Side) Ctrl+8
Open Perspective 2
Show View 3

Customize Perspective...
Save Perspective As...
Reset Perspective...
Close Perspective

Close All Perspectives
Mavigation 2

Preferences

3. Apds o filtro da pesquisa aplicado, va em “Installations” -> “Add”. Vocé ird
adicionar o maven contigo no diretério:
> \\selene\GRUPO\NTI\SISTEMAS\JAVA\WINDOWS\

Pegue o arquivo “apache-maven-3.0.4" e descompacte no diretério criado

ferramentas. Aponte para este caminho no eclipse;
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o,

Lr

maven

4 JBoss Tools

JBoss Maven Integrati
4 Maven

Archetypes

Discovery

Templates

User Interface

User Settings

WTPF integration

Installations Pr T
Select the installation used to launch Maven:
[J Embedded (3.0.2/1.0.100.20110804-1717) Add...
External D:\ava\ferramentasiapache-maven-3.0.4 (3.0.4) =
Edit...
Remowve
MNote: Embedded runtime is always used for dependency
resclution, but does not use global settings when it is used to
launch Maven. To learn more, visit the Maven web page.
Global settings from installation directory (open file):
D:\Java\ferramentas\apache-maven-3.0.4\ conf\settings.xml Browse...

4. Ainda com o filtro de pesquisa ativado va em “User Settings” -> “Browse...”. Vocé

ira selecionar o arquivo settings.xml contido no diretério maven que vocé colocou em

ferramentas. Para encontrar o arquivo navegue em ‘“\apache-maven-

3.0.4\confisettings.xml ”’;

maven

4 JBoss Tools
JBoss Maven Integrati
4 Maven
Archetypes
Discovery
Installations
Templates
User Interface
User Settings
WTP integration

User Settings T T

User Settings (cpen file):
D'Java\ferramentas\apache-maven-3.0.4\ conf\settings.ml Browse...

Update Settings

Local Repository (From merged user and glebal settings):
C\Users\3506\.m2\repository Reindex

5. Vocé podera importar entdo um projeto. Va em “File” -> “Import”, uma nova janela

sera aberta. Selecione “General ” -> “EXxisting Project into Workspace ” e clique em

“Next”. Em “Browse..

. escolha o projeto que devera estar no seu workspace. Por

fim clique em “Finish” e aguardo o eclipse dar build no projeto.
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File | Edit Refactor 5Source Mavigate Search Project Run  Window

New Alt+5Shift+M » I3
Open File... e
Close Ctrl+W
Close All Ctrl+Shift+W
Save Ctrl+5
Save As...
Save All Ctrl+Shift+5
Revert
Move...
Rename... F2
& Refresh F5
Convert Line Delimiters To 3
Print... Ctrl+P
Switch Workspace 3
Restart
f2g  Import... |I
3  Export...
Properties Alt+Enter
1 EventeMetadadoDACImpl.java [SigaWeb...]
2 RelatorioGeralDAO java [SigaWebGere...]

3 Boas Praticas de Configuracao

Embora sua IDE ja esteja pronta para o desenvolvimento, existem otimizagdes da ferramenta
que podem proporcionar uma melhor experiéncia durante o processo de desenvolvimento,
aumentando ainda mais a produtividade.

3.1 Configurando Save
Para que ao salvar o eclipse ja organize seu codigo e faca os imports de pacote de forma

automatica, siga as configuracdes abaixo:
Va em “Window ” -> “Preferences”, digite a palavra save e selecione em Java -> Editor ->

Save Actions.

save Save Actions = o o
G | ] : . .
o e Configure Project Specific Settings...
Waorkspace ]
4 lava Perform the selected actions on save
4 Editor Format source code
Save Actions (®) Format all lines
4 JavaScript () Format edited lines
4 Editor Configure the formatter settings on the Formatter page.
Save Actions Organize imports

Configure the organize imports settings on the Organize Imports page.
[+] Additicnal actions

» Add final modifier to private fields Configure...
» Add missing '@ Override’ annotations

» Add missing '@Override’ annotations to implementations of interface methods

» Add missing '@Deprecated’ annotations

= Remove unnecessary casts

Selecione as op¢des conforme a imagem.
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3.2 Configurando Encoding
Para evitar incompatibilidades de codificacdo ao subir para o servidor vocé podera ajustar

0 encoding do eclipse para o padrao UTF-8.

Va em “Window” -> “Preferences”, digite a palavra encoding e selecione em General ->

Workspace.
.1:} X
encoding Workspace P T
4 General See 'Startup and Shutdown' for workspace startup and shutdown preferences.
Content Types
_Workspace
4 Web [+] Build automatically
(S5 Files [[] Refresh using native hooks or polling
HTML Files []Refresh on access
J5P Files [] Save automatically before build
4 XML [] Always close unrelated projects without prompt
XML Files

Workspace save interval (in minutes): | 5

Workspace name (shown in window title):

Open referenced projects when a project is opened

() Always () Never (8 Prompt

Text file encoding Mew text file line delimiter
() Default (Cp1252) (®) Default
(@) Other: | UTF-8 v () Other:

Selecione as opcbes conforme a imagem.
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3.3 Configurando Text
Com o objetivo de aumentar a produtividade de desenvolvimento, vocé podera configurar seu

eclipse para tabulacéo e endentac@o do codigo se ajustar em um padrao.
Va em “Window ” -> “Preferences”, digite a palavra text e selecione em General -> Editors

-> Text Editors.

'I:} x
text Text Editors (CR A A
4 General See 'Colors and Fonts' to configure the font. ~
4 Appearance
Colors and Fonts Undo history size: 200
4 Editors
Structured Text Ed Displayed tab width: 4
Bl Insert spaces for tabs
Accessibility Highlight current line
An Hions []Show print margin
Hyperlinking
Quick Diff Print margin column: 80
Spelling Show line numbers
4 Team [] Show range indicator
4 Cvslabel Dec []show whitespace characters
orations
4 Weh Show affordance in hover on how to make it sticky
4 (55 Files When mouse moved inte hover: | Enrich after delay W
4 Editor [¥]Enable drag and drop of text
HTML :;Iy Coloring Warn before editing a derived file
rl nes
4+ Editor [#] Smart caret positioning at line start and end
ISP Fil Sy Colaring Appearance color options:
rl nes
+ Editor Line number foreground Color: | N
s Colori Current line highlight
yntax ring Print margin
4 XML Find scope
4 DTD Files Selection foreground color
Syntax Coloring Selection background color
4 XML Files Background coler
. Foreground color
4 Editor Hyperlink
Syntax Coloring
More colors can be configured on the 'Colors and Fonts' preference page.
£ > Restore Defaults Apply hd
@

Selecione as opgdes conforme a imagem.
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3.4 Configurando Perspective

Existem diversas perspectivas oferecidas pela IDE, para o desenvolvimento web é
recomendavel a utilizagdo da “\Web Development”.

Va em “Window” -> “Open Perspective” -> “Other”. Uma nova janela serd aberta, nela

escolha a opcdo Web Development.

! MNew Window
Mew Editor
MNew Editor (Side by Side)

Window | Help

Ctrl+8

| Open Perspective

» | %5 Debug

Show View

Customize Perspective...
Save Perspective As...
Reset Perspective..,
Close Perspective

Close All Perspectives
Mavigation

Preferences

» a’ Java
g.’ Java Browsing

| Other...

Lai
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& Java

7 Java Browsing

79 Java EE (default)
TgJJava Type Hierarchy
a"’J avascript

2 IMK

& IPA

(1) Planning

== Plug-in Development
E Remote System Explorer
[[\:, Resource

i+ Seam 2

EBTeam Synchrenizing

& Web

@Web Development

XML

Cancel




3.5 Configurando Apresentagdo de Pacote

Ainda por priorizar uma visdo mais amigavel dos muitos pacotes existentes, recomenda-se a
visdo hierarquica dos mesmos. Esta pode ser feita da seguinte forma:

Selecione um projeto ja importado.

Proximo a opgdo de minimizar selecione uma ‘seta para baixo’ que corresponde ao “View

Menu” (figue atento pois nao é facil de visualizar). Apos esta etapa via em “Package Presentation

e escolha o modo “Hierarchical .

[% Package Explorer &7 = <-=|'=L{>| & @D 8
11 AreaDoAluno Top Level Elements k
1 AreaDoContratante
7 Checkout Select Working Set...
- ¥ Dominio Deselect Working Set
1T Infraestrutura Edit Active Working Set...
» =% Servers

&

1.1 SigaWebAcesso 1 Window Working Set

127 SigaWebAcessoCore . Filters
» N = SigaWebBatch [SigaWebBatch v0.0.5] T
s :_—EJ; SigaWebGerencial [SigaWebGerencial master] Package Presentation k| 8= Flat
e ] . - T
4 |lLTT SigaWebProtocolo [SigaWebProtocolo mﬂm‘-fﬂ Show 'Referenced Libraries' Mode Hierarchical
+ [#H src/mainfjava
E,

s [;% src/resources Link with Editor

- [ src/test{java
> =% JRE System Library [JavaSE-1.6]
» =i Maven Dependencies
> [ src
> = target
[} pom.axm
EE, teste bt
121 SigaWebSeguranca

5T TramaitaranDrntnrala

Focus on Active Task
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3.6 Suspendendo Validag¢oes
Para manter uma melhor performance no seu eclipse, é recomendavel suspender que ele faca

sempre varias validacGes que muitas vezes sao desnecessarias. Este procedimento pode ser feito da
seguinte forma:

Va em “Window” -> “Preferences”, digite a palavra validation e selecione em Validation.

validation Yalidation T T
4 General
a Editors
Structured Text Ed Allow projects to override these preference settings
4 JBoss Tools Suspend all validators
a Web []5ave all modified resources autornatically prior to validating
4 BExpression Languag Show a confirmaticn dialeg when performing manual validations
Validati
ISE = fon The selected validators will run when validation is performed:
a
Validation Validator Manual Build Setting: ™
Application Client (1) Validator % %
2 Web Classpath Dependency Validator o o
4 HTML Files Client-side lavaScript Validator o
Validation Connector (1.0,1.3) Validator v’ o
4 JEW:EI:;:-FECES Tools DTD Validator — — _I
e F‘,’I on EJE (1.x-2.x) Validator % %
) vlalei;ath" Eiglxvaliiat? tion (1.x) Validat : : -
4 Web Services nterprise App |ca- ion (1.x) Validator
Wizard Validation Facelet HTML Validator v 7 o]
L XML HTML Syntax Validator - o ]
4 XML Files JAXB Validator v [T
Validation JBoss Tools Project Validator ' v
4 XML Schema Files JPA Validator % ]
Validation J5F Application Cenfiguration Validator v o _|
4 XSL JSF View Validator - 7 ]
Validation ISP Content Validator 7 7 o v
£ >
Enable All | Disable All
a & Restore Defaults Apply

©

Selecione as opcbes conforme a imagem.
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3.7 Plugindo GIT
Uma das ferramentas essenciais no processo de desenvolvimento interno é o controlador de

versdo GIT, nesta recomendacdo de boas praticas utilizaremos o plugin ja contigo no eclipse

disponibilizado para termos o controle em nosso eclipse também. Este procedimento pode ser feito

da seguinte forma:

Selecione um projeto e clique com o botao direito do mouse nele. Va em “Team” -> “Share

Project”.

File Edit Source Ref
9w
e —
[# Package Explorer &3

T AreaDodAlunc
7 AreaDoContratan
L7 AutoAtendiment
1 Checkout
> T4 Dominio [Dormin
T Infraestrutura
s = Servers
LT SigaWebAcesso
107 SigaWebAcessod
LT SigaWebBatch
L7 SigaWebCompra
L7 SigaWebGerenciz
L1 SigaWebProtoco
107 SigaWebSeguran
4 "lg? TramitacaoProto
s [ sro/main/jave
> [ src/resources
s [ srcftest/java
» = JRE Systemn Li
» =4, Maven Deper|
> B Apache Tom
» 2= doc
> (= sre
» [ target
[ pemaxml

;-:l Sign in to Google...

e. FE i—

x & (i

% OLE

=

Google Web Toolkit
MNew

Go Into

Open in New Window
Open Type Hierarchy

Show In

Copy
Copy Qualified Name
Paste
Delete

Remove from Context
Build Path
Source

Refactor

Import...
Export...

Refresh

Close Project

Close Unrelated Projects
Assign Working Sets...

Run As

Debug As

Profile As

Mark as Deployable
Validate

Team

Compare With

Restore from Local History...

Maven
Java EE Tools
Google

L3
3

F\d
Alt+Shift+W »

Ctrl+C

Ctrl+V
Delete

Ctrl+Alt+Shift+Down
»
Alt+Shift+5 »
Alt+Shift+T ¥

F5

0| p 0 P56 i

Apply Patch...

Share Project...
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Selecione a Opcgdo do GIT

e

ik X

Share Project Y
Select the repository plug-in that will be used to share the selected project.

Select a repository type:
B ovs

E" Git

@ < Back Next > Finish

Iremos utilizar um repositorio ja existente. Selecione o campo destacado em preto.
& x

Configure Git Repository T
1]
Please select an existing repositery or create a new one lﬁ

@se or create repository in parent folder of project
epository: | V| | Create... |

Working directory: | Mo repository selected |

Path within repository: | | Browse...

Project Name Current Location Target Location

[] TramitacaoProtocolo  D:/)ava/workspace/TramitacaoProtocolo

® vots ||
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O eclipse ira localizar o diretorio “.git” do seu projeto, selecione e finalize a operagao.

Configure Git Repository

Select Git repository location

Use or create repository in parent folder of project

Project Path Repository

Tramitacac D:\Java\workspace\TramitacaoProtocolo .git
Create Repository \.git
@ Next > finish || Cancel

Quando vocé clicar ir novamente em Team no seu projeto podera observar os recursos do git, assim
como o eclipse ira lhe mostrar a versdo em que esta trabalhando bem ao lado do nome do mesmo.

- pvelopment - Edipse

File Edit 5Source Refactor Mavigate Search Google Web Toolkit 4
M 3 = =
Ch~ &8 & - |0 @~ = | o A
Go Into

[# Package Explorer &3

127 AreaDoAlunc
127 AreaDoContratante

Open in New Window
Open Type Hierarchy

F4

Ed

-,-:l Signinte Google.. - [

TramitacaoPr

Restore from Local History...

Maven

Java EE Tools

17 AutoAtendimento Show In Alt+Shift+ W »
127 Checkout §
3 I,—‘Djs Dominio [Dominio master] = Copy Crl+C
17 Infraestrutura 55 Copy Qualified Name
1= Servers [E Paste Ctrl+V
17 SigaWebAcesso % Delete Delete
1071 SigaWebAcessoCore
{07 SigaWebBatch Remaove from Context Ctrl+Alt+Shift+ Down
T SigaWebCompras Build Path »
o S!gaWebGerench Source Alt+5hift+5 »
1.7 SigaWebProtocolo - T
101 SigaWebSeguranca Bk BRnErD
4 |"'E'DJ, = TramitacacProtocolo [TramitacacProtocol £ Import.
i [#f sr¢/main/java a
Export...
I [## src/resources = B
[ (5 sroftest/java " Refresh F5
|» B JRE System Library [JavaSE-1.5] Close Project
[ =i Maven Dependencies .
Close Unrelated Project:
> =4 Apache Tomcat v6.0 [Apache Tomcat vé. i
b G dec Assign Working Sets...
b & > sre Run As 3
[ target
& targ Debug As 3
EE, pom.xml
Profile As 3
By Mark as Deployable
Validate
| Team 3
Compare With 3
Replace With 3

of

L=}

w =

9
ot

Commit... Ctrl+#

Fetch from Upstream
Push to Upstream

Remote 3
Switch To »

Advanced »
Pull
Synchronize Workspace

Merge Tool
Merge...

Reset...

Rebase...

Create Patch...

Apply Patch...
Ignore

Add to Index
Untrack

Show in Repositories View

Show in History

Disconnect
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